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THIEÁT KEÁ MAÏCH IN MAÏCH AVR  
CUÛA MAÙY PHAÙT COÂNG SUAÁT NHOÛ 

  
Trong baøi taäp naøy baïn seõ ñöôïc höôùng daãn thieát keá maïch in cho maïch AVR cuûa maùy phaùt 

coâng suaát nhoû coù sô ñoà nguyeân lyù nhö sau : 

 

 Muoán khôûi ñoäng 
chöông trình veõ sô ñoà 
nguyeân lyù trong OrCAD, haõy 
nhaáp choïn Start > 
Programs > OrCAD 
Release 9 > Capture. 
 Maøn hình OrCAD 
Capture xuaát hieän, choïn 
File > New > Project. Hoäp 
thoaïi New Project xuaát 
hieän. Taïi khung Name, nhaäp 
teân caàn ñaët cho maïch vaøo, 
taïi khung Location nhaáp 
chuoät vaøo nuùt Browse ñeå 
choïn ñöôøng daãn cho maïch 
göûi vaøo. Choïn xong nhaáp 
OK. 
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 Maøn hình laøm vieäc cuûa Orcad xuaát hieän, ñeå laáy linh kieän cho maïch, haõy nhaáp chuoät vaøo 
bieåu töôïng Place part treân thanh coâng cuï. 
 Trong maïch naøy goàm coù : 1 RAÉC CAÉM 2 CHAÂN, 2 TUÏ PHAÂN CÖÏC, 6 DIODE, 8 
ÑIEÄN TRÔÛ, 3 BIEÁN TRÔÛ, 1 TUÏ KHOÂNG PHAÂN CÖÏC, 1 COÂNG TAÉC, 4 RAÉC CAÉM 1 
CHAÂN, 1 SCR, 1 DIODE ZENNER, 1 JFET, 1 TRANSISTOR PNP, 1 RELAY. 

 
 Hoäp thoaïi Place Part xuaát hieän, trong khung Libraries khoâng coù nhöõng muïc chöùa linh 
kieän caàn thieát cho maïch neân haõy nhaáp chuoät vaøo nuùt Add Library ñeå laáy muïc chöùa linh kieän 
caàn thieát. 

 
 Hoäp thoaïi Browse File xuaát hieän, tröôùc tieân laáy ñieän trôû neân haõy nhaáp chuoät vaøo teân 
Discrete. Choïn xong nhaáp Open. 
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 Hoäp thoaïi Place Part xuaát hieän vôùi muïc Discrete ñaõ ñöôïc naïp vaøo khung Libraries. Ñeå 
laáy ñieän trôû, nhaáp chuoät vaøo muïc Discrete. Taïi khung Part nhaáp chuoät vaøo thanh cuoán beân phaûi 
ñeå tìm R. Tìm thaáy nhaáp choïn noù. Choïn xong nhaáp OK. Con troû chuoät xuaát hieän hình daïng dieän 
trôû, di chuyeån noù ra maøn hình laøm vieäc vaø nhaáp chuoät taïi nhöõng vò trí khaùc nhau ñeå choïn vò trí, 
soá löôïng ñieän trôû. 

 
 Ñeå tieáp tuïc laáy bieán trôû, nhaáp chuoät vaøo bieåu töôïng Place part treân thanh coâng cuï, hoäp 
thoaïi Place Part xuaát hieän. Taïi khung Libraries nhaáp choïn muïc Discrete, taïi khung Part nhaáp 
choïn teân RESISTOR VAR. Choïn xong nhaáp OK vaø di chuyeån con troû ra maøn hình laøm vieäc ñeå 
nhaáp choïn vò trí, soá löôïng bieán trôû. 
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 Ñeå choïn DIODE, nhaáp chuoät vaøo bieåu töôïng Place part treân thanh coâng cuï. Hoäp thoaïi 
Place Part xuaát hieän, taïi khung Part nhaáp choïn teân DIODE. Choïn xong nhaáp OK vaø di chuyeån 
con troû ra maøn hình laøm vieäc nhaáp choïn vò trí, soá löôïng DIODE. 

 
 Ñeå choïn Diode zener, nhaáp chuoät vaøo bieåu töôïng Place part treân thanh coâng cuï. Hoäp 
thoaïi Place Part xuaát hieän, taïi khung Part nhaáp choïn teân DIODE ZENER. Choïn xong nhaáp 
OK vaø di chuyeån con troû ra maøn hình laøm vieäc nhaáp choïn vò trí zener. 

 
 Ñeå choïn tuï khoâng phaân cöïc, nhaáp chuoät vaøo bieåu töôïng Place part treân thanh coâng cuï. 
Hoäp thoaïi Place Part xuaát hieän, taïi khung Part nhaáp choïn teân CAP NP. Choïn xong nhaáp OK 
vaø di chuyeån con troû ra maøn hình laøm vieäc nhaáp choïn vò trí tuï. 
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 Ñeå choïn tuï phaân 
cöïc, nhaáp chuoät vaøo 
bieåu töôïng Place part 
treân thanh coâng cuï. 
Hoäp thoaïi Place Part 
xuaát hieän, taïi khung 
Part nhaáp choïn teân 
CAPACITOR POL. 
Choïn xong nhaáp OK vaø 
di chuyeån con troû ra 
maøn hình laøm vieäc 
nhaáp choïn vò trí, soá 
löôïng tuï. 

 

 Ñeå choïn SCR, nhaáp 
chuoät vaøo bieåu töôïng Place 
part treân thanh coâng cuï. Hoäp 
thoaïi Place Part xuaát hieän, taïi 
khung Part nhaáp choïn teân 
S2800. Choïn xong nhaáp OK vaø 
di chuyeån con troû ra maøn hình 
laøm vieäc nhaáp choïn vò trí SCR. 
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 Ñeå choïn Coâng taéc, nhaáp chuoät vaøo bieåu töôïng Place part treân thanh coâng cuï. Hoäp thoaïi 
Place Part xuaát hieän, taïi khung Part nhaáp choïn teân SENS59145-SPST. Choïn xong nhaáp OK vaø 
di chuyeån con troû ra maøn hình laøm vieäc nhaáp choïn vò trí coâng taéc. 

 
 Ñeå choïn JFET, nhaáp chuoät vaøo bieåu töôïng Place part treân thanh coâng cuï. Hoäp thoaïi 
Place Part xuaát hieän, taïi khung Part nhaáp choïn teân MU4893. Choïn xong nhaáp OK vaø di 
chuyeån con troû ra maøn hình laøm vieäc nhaáp choïn vò trí JFET. 

 
 Ñeå choïn RELAY, nhaáp chuoät vaøo bieåu töôïng Place part treân thanh coâng cuï. Hoäp thoaïi 
Place Part xuaát hieän, taïi khung Part nhaáp choïn teân RELAY SPDT. Choïn xong nhaáp OK vaø di 
chuyeån con troû ra maøn hình laøm vieäc nhaáp choïn vò trí RELAY. 
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 Ñeå laáy chaân caém 
(khoâng coù trong muïc naøy), nhaáp 
chuoät vaøo bieåu töôïng Place 
part treân thanh coâng cuï. Hoäp 
thoaïi Place Part xuaát hieän, ñeå 
laáy muïc coù chöùa chaân caém, 
nhaáp chuoät vaøo nuùt Add 
Library. 

Hoäp thoaïi Browse File 
xuaát hieän, nhaáp chuoät vaøo 
thanh cuoán beân döôùi ñeå tìm vaø 
choïn muïc Connector. Choïn 
xong nhaáp Open. 
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 Hoäp thoaïi Place Part xuaát hieän, taïi khung Libraries nhaáp choïn muïc CONNECTOR. 
Taïi khung Partnhaáp choïn CHAÂN CAÉMcaàn, ôû ñaây ta nhaáp chuoät vaøo teân CON1. Choïn xong 
nhaáp OK vaø di chuyeån con troû ra maøn hình laøm vieäc roài nhaáp choïn vò trí, soá löôïng chaân caém. 

 
 Ñeå laáy chaân caém 2 chaân, nhaáp chuoät vaøo bieåu töôïng Place part treân thanh coâng cuï. Hoäp 
thoaïi Place Part xuaát hieän, taïi khung Libraries nhaáp choïn muïc CONNECTOR. Taïi khung 
Part nhaáp choïn CHAÂN CAÉM caàn thieát, ôû ñaây nhaáp chuoät vaøo teân CON2. Choïn xong nhaáp OK 
vaø di chuyeån con troû ra maøn hình laøm vieäc roài nhaáp choïn vò trí chaân caém. 

 
 Ñeå laáy Transistor (khoâng coù trong muïc naøy), nhaáp chuoät vaøo bieåu töôïng Place part treân 
thanh coâng cuï. Hoäp thoaïi Place Part xuaát hieän, ñeå laáy muïc coù chöùa Transistor, nhaáp chuoät vaøo 
nuùt Add Library. 
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 Hoäp thoaïi Browse File xuaát hieän, nhaáp chuoät vaøo thanh cuoán beân döôùi ñeå tìm vaø choïn 
muïc Transistor. Choïn xong nhaáp Open. 

 

 Hoäp thoaïi Place Part 
xuaát hieän, taïi khung 
Librariesnhaáp choïn muïc 
TRANSISTOR. Taïi khung 
Part nhaáp choïn Transistorcaàn, 
ôû ñaây ta nhaáp chuoät vaøo teân 
2N3637. Choïn xong nhaáp OK 
vaø di chuyeån con troû ra maøn 
hình laøm vieäc roài nhaáp choïn vò 
trí Transistor. 
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 Sau khi taát caû caùc linh kieän ñaõ ñöôïc laáy ra maøn hình laøm vieäc, ñeå hình daïng linh kieän 
khoâng xuaát hieän taïi con troû chuoät nöõa, nhaáp chuoät vaøo bieåu töôïng Select treân thanh coâng cuï. 

 
 Sau khi laáy taát caû caùc linh kieän ra maøn hình laøm vieäc, caùc linh kieän trong maøn hình laøm 
vieäc nhö sau: 

 
 Tieáp tuïc tieán haønh saép xeáp linh kieän. Muoán di chuyeån linh kieän, nhaáp chuoät vaøo bieåu 
töôïng linh kieän vaø reâ chuoät. Muoán quay linh kieän ñoái xöùng qua truïc ñöùng, nhaáp choïn linh kieän 
roài nhaáp phaûi chuoät. Moät cöûa soå xuaát hieän, nhaáp chuoät vaøo Mirror Horizontally. Muoán quay 
linh kieän moät goùc 90o, nhaáp choïn linh kieän roài nhaáp phaûi chuoät. Moät cöûa soå xuaát hieän, nhaáp 
chuoät vaøo Rotate. Muoán quay linh kieän ñoái xöùng qua truïc naèm ngang, nhaáp choïn linh kieän roài 
nhaáp phaûi chuoät. Moät cöûa soå xuaát hieän, nhaáp chuoät vaøo Mirror Vertically. 

      
 Trong khi di chuyeån, coù khi hai chaân linh kieän chaïm nhau. Hoäp thoaïi OrCAD Capture 
xuaát hieän raèng neáu muoán noái hai chaân linh kieän naøy vôùi nhau thì nhaáp OK. Neáu khoâng muoán 
noái thì nhaáp OK roài nhaáp vaøo bieåu töôïng Undo treân thanh coâng cuï ñeå di chuyeån laïi. 
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 Sau khi di chuyeån caùc linh kieän theo sô ñoà nguyeân lyù, caùc linh kieän saép xeáp nhö sau: 

 
 Tieáp tuïc tieán haønh noái chaân caùc linh kieän theo sô ñoà nguyeân lyù. Nhaáp chuoät vaøo bieåu 
töôïng Place wire treân thanh coâng cuï. Con troû chuoät thay ñoåi thaønh hình chöõ thaäp, nhaáp chuoät taïi 
chaân linh kieän caàn noái roài di chuyeån con troû ñeán chaân linh kieän caàn noái vôùi noù vaø nhaáp chuoät. 
Nhöõng chaân naøokhoâng muoán keát noái thì nhaáp chuoät vaøo bieåu töôïng Place no connect treân thanh 
coâng cuï roài di chuyeån con troû ñeán chaân khoâng keát noái vaø nhaáp chuoät. 

   
 Cöù theá tieáp tuïc cho ñeán khi taát caû caùc linh kieän ñöôïc noái theo sô ñoà nguyeân lyù sau: 
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 Ñeå thay ñoåi giaù trò 
linh kieän, nhaáp ñuùp chuoät 
vaøo giaù trò linh kieän. Hoäp 
thoaïi Display Properties 
xuaát hieän, taïi khung 
Value nhaäp giaù trò caàn 
ñaët cho linh kieän. Nhaäp 
giaù trò xong nhaáp OK. 

 

 Trong khi thay ñoåi giaù 
trò linh kieän, coù nhöõng giaù trò 
linh kieän khoâng caàn thay ñoåi 
cuõng nhö khoâng muoán cho noù 
xuaát hieän treân maïch ñieän, 
nhaáp ñuùp vaøo giaù trò linh 
kieän ñoù. Hoäp thoaïi Display 
Properties xuaát hieän, taïi 
khung Display Format nhaáp 
chuoät vaøo muïc Do not 
Display. Choïn xong nhaáp 
OK. 

 

 Sau khi thay ñoåi giaù trò linh kieän, caùc linh kieän trong maïch nhö sau: 
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 Ñeå kieåm tra loãi cho sô ñoà nguyeân lyù vaø chuyeån sang sô ñoà 
maïch in, nhaáp chuoät vaøo bieåu töôïng Minimize goùc phaûi phía treân 
maøn hình. 

 
 Maøn hình nhö sau xuaát hieän, taïi khung beân traùinhaáp choïn trang PAGE1. Sau ñoùnhaáp 
chuoät vaøo bieåu töôïng Design rules check ñeå kieåm tra loãi. 

 
 Hoäp thoaïi Design Rules Check xuaát hieän, nhaáp chuoät vaøo nuùt OK ñeå tieán haønh kieåm 
tra. Neáu khoâng thaáy thoâng baùo gì nghóa laø maïch khoâng coù loãi. 
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 Tieáp tuïc taïo taäp tin coù ñuoâi .mnl 
ñeå thieát keá maïch in. Nhaáp chuoät vaøo 
bieåu töôïng Create netlist treân thanh 
coâng cuï. 

 

 Hoäp thoaïi 
Create netlist xuaát 
hieän, nhaáp chuoät 
vaøo Layout, taïi 
khung Netlist File 
coù theå nhaáp chuoät 
vaøo nuùt Browse ñeå 
choïn ñöôøng daãn 
cho taäp tin ñöôïc göûi 
vaøo. Choïn xong 
nhaáp OK. 

Moät hoäp 
thoaïi xuaát hieän 
thoâng baùo laø taäp tin 
treân seõ ñöôïc Save 
ñeå keát noái. Nhaáp 
OK ñeå tieáp tuïc. 

 
 Tieáp tuïc chuyeån 
sang cheá ñoä thieát keá maïch 
in, haõy nhaáp choïn Start > 
Programs > OrCAD 
Release 9 > Layuot Plus.  
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 Maøn hình thieát keá maïch in xuaát hieän, 
nhaáp choïpn File > New ñeå môû moät File môùi. 

 
 Hoäp thoaïi Load Template File xuaát hieän, nhaáp chuoät vaøo nuùt Open. 

 

 Hoäp thoaïi Load Netlist 
Source xuaát hieän, nhaáp choïn 
teân maïch caàn thieát keá maïch in. 
Choïn xong nhaáp Open. 

 

 Hoäp thoaïi Save File As 
xuaát hieän, taïi khung File name 
nhaäp teân caàn ñaët cho maïch in 
vaøo (tuøy choïn). Nhaäp xong 
nhaáp chuoät vaøo nuùt Save. 
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 Sau moät thôøi gian chôø ñôïi, hoäp thoaïi nhö sau xuaát hieän. Trong hoäp thoaïi Link Footprint 
to Component coù thoâng baùo laø khoâng theå tìm thaáy chaân maïch in cuûa Q1 coù teân laø S2800. Vì theá 
neân phaûi tìm chaân cho linh kieän naøy baèng caùch nhaáp chuoät vaøo nuùt Link existing footprint to 
component… 

 
 Hoäp thoaïi Footprint for S2800 xuaát hieän, taïi khung Librariesnhaáp choïn muïc TO. Taïi 
khung Footprintsnhaáp choïn muïc TO202AA ñeå choïn chaân maïch in cho SCR. Choïn xong nhaáp 
Ok. 

 
 Hoäp thoaïi Link Footprint to Component xuaát hieän thoâng baùo laø khoâng theå tìm thaáy 
chaân maïch in cuûa SW1 coù teân laø SENS591 45-SPST. Vì theá neân phaûi tìm chaân cho linh kieän naøy 
baèng caùch nhaáp chuoät vaøo nuùt Link existing footprint to component… 
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 Hoäp thoaïi 
Footprint for 
SENS591 45-
SPST xuaát hieän, 
taïi khung 
Libraries nhaáp 
choïn muïc 
JUMPER. Taïi 
khung Footprints 
nhaáp choïn muïc 
JUMPER400 ñeå 
choïn chaân maïch 
in cho coâng taéc. 
Choïn xong nhaáp 
Ok. 

 

 Hoäp thoaïi Link 
Footprint to Component 
laïi xuaát hieän vôùi thoâng baùo 
laø khoâng theå tìm thaáy chaân 
maïch in cuûa Q2 coù teân laø 
MU4893. Vì theá neân caàn 
tìm chaân cho linh kieän naøy 
baèng caùch nhaáp chuoät vaøo 
nuùt Link existing footprint 
to component… 
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 Hoäp thoaïi 
Footprint for 
MU4893 xuaát 
hieän, taïi khung 
Libraries nhaáp 
choïn muïc TO. 
Taïi khung 
Footprints nhaáp 
choïn muïc 
TO202AB ñeå 
choïn chaân maïch 
in cho 
Transistor. Choïn 
xong nhaáp Ok. 

 
 Hoäp thoaïi Link 
Footprint to Component 
xuaát hieän thoâng baùo khoâng 
theå tìm thaáy chaân maïch in 
cuûa J1 coù teân laø CON1. Vì 
theá, haõy tìm chaân cho linh 
kieän naøy baèng caùch nhaáp 
chuoät vaøo nuùt Link existing 
footprint to component… 

 
Hoäp thoaïi 
Footprint for 
CON1 xuaát hieän, 
taïi khung 
Libraries nhaáp 
choïn muïc 
BCON100T. Taïi 
khung Footprints 
nhaáp choïn muïc 
BLKCON.100/VH/  
TM1SQ/W100/1 
ñeå choïn chaân maïch 
in cho chaân caém. 
Choïn xong nhaáp 
Ok. 
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 Hoäp thoaïi Link 
Footprint to Component 
tieáp tuïc xuaát hieän thoâng 
baùo khoâng theå tìm thaáy 
chaân maïch in cuûa Q3 coù 
teân laø 2N3637. Vì theá neân 
phaûi tìm chaân cho linh kieän 
naøy baèng caùch nhaáp chuoät 
vaøo nuùt Link existing 
footprint to component… 

 
 Hoäp thoaïi 
Footprint for 
2N3637 xuaát hieän, 
taïi khung Libraries 
nhaáp choïn muïc TO. 
Taïi khung 
Footprints nhaáp 
choïn muïc 
TO202AC ñeå choïn 
chaân maïch in cho 
JFET. Choïn xong 
nhaáp Ok. 

 
 Sau khi choïn chaân cho caùc linh kieän, caùc linh kieän trong sô ñoà maïch in nhö sau: 

 

ÑAÏI HOÏC SÖ PHAÏM KYÕ THUAÄT – KHOA ÑIEÄN   BIEÂN SOAÏN : PHAÏM QUANG HUY  -  HUYØNH MINH ÑAÊNG 199 



GIAÙO TRÌNH EDA (ELECTRONIC DESIGN AUTOMATION) - TÖÏ ÑOÄNG THIEÁT KEÁ MAÏCH ÑIEÄN TÖÛ VÔÙI ORCAD          BAØI TAÄP 8 
 

 Ta tieán haønh saép xeáp caùc linh kieän. Ñeå khoâng bò giôùi haïn bôûi khung maïch in coù saün, haõy 
nhaáp chuoät vaøo bieåu töôïng Reconnect Mode treân thanh coâng cuï. 

 
 Sau khi nhaáp chuoät vaøo bieåu töôïng Reconnect Mode, caùc linh kieän trong maïch nhö hình. 

 
 Muoán di chuyeån linh kieän, haõy nhaáp chuoät vaøo bieåu töôïng linh kieän vaø reâ chuoät ñeán vò trí 
caàn ñaët linh kieän roài nhaáp chuoät. Muoán quay linh kieän moät goùc 90o, nhaáp choïn bieåu töôïng linh 
kieän roài nhaáp phaûi chuoät, moät cöûa soå xuaát hieän,nhaáp chuoät vaøo Rotate hay nhaán phím R treân 
baøn phím. 
 Sau khi saép xeáp xong, caùc linh kieän ñöôïc saép xeáp trong maïch nhö sau: 

 
 Ñeå cho maïch in khoâng coøn roái nöõa, haõy cho aån caùc teân khoâng caàn thieát cuûa linh kieän 
baèng caùch taïi khung traïng thaùi, nhaáp chuoät ngay muõi teân höôùng xuoáng cuûa 1 TOP vaø choïn 23 
AST. 
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 Sau ñoù, nhaáp choïn View > Visible <> Invisible ñeå cho aån nhöõng teân naøy. Muoán cho hieän 
laïi, haõy thöïc hieän laïi nhöõng böôùc treân moät laàn nöõa. 

 
 Sau khi cho aån teân linh kieän, caùc linh kieän trong maïch nhö sau: 

 
 Ñeå veõ khung giôùi haïn cho maïch in, nhaáp chuoät 
vaøo bieåu töôïng Obstacle Tool treân thanh coâng cuï.  
  Con troû chuoät thay ñoåi hình daïng, nhaáp chuoät taïi moät ñieåm caàn ñaët cho khung giôùi haïn, 
di chuyeån con troû ñeán ñieåm caàn ñaët khaùc vaø nhaáp chuoät. Cöù theá tieáp tuïc cho ñeán khi khung 
maïch in hoaøn chænh nhö sau: 

 

ÑAÏI HOÏC SÖ PHAÏM KYÕ THUAÄT – KHOA ÑIEÄN   BIEÂN SOAÏN : PHAÏM QUANG HUY  -  HUYØNH MINH ÑAÊNG 201 



GIAÙO TRÌNH EDA (ELECTRONIC DESIGN AUTOMATION) - TÖÏ ÑOÄNG THIEÁT KEÁ MAÏCH ÑIEÄN TÖÛ VÔÙI ORCAD          BAØI TAÄP 8 
 

 Sau khi khung giôùi haïn maïch in hoaøn thaønh, ñeå thoaùt khoûi leänh naøy ta nhaáp phaûi chuoät, 
moät cöûa soå xuaát hieän,nhaáp chuoät vaøo End Command. 

 
 Ñeå choïn lôùp cho chöông trình chaïy 
maïch in, nhaáp chuoät vaøo bieåu töôïng daïng caroâ 
treân thanh coâng cuï. Moät cöûa soå xuaát hieän, 
nhaáp chuoät vaøo Strategy… > Route Layer.  
 Hoäp thoaïi Route Layer xuaát hieän, ta nhaáp choïn taïi taát caû caùc oâ trong coät Enable, doøng 
BOTTOM, INNER1, INNER2. Choïn xong nhaáp phaûi chuoät, moät cöûa soå xuaát hieän, nhaáp choïn 
Properties. 

 
 Hoäp thoaïi Edit Layer Strategy xuaát hieän, nhaáp boû muïc Routing Enabled. Xong ta nhaáp 
OK. 
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 Hoäp thoaïi Route Layer xuaát hieän,nhaáp chuoät vaøo bieåu töôïng Close ôû goùc phaûi phía treân 
hoäp thoaïi. 

 
 Cho chöông trình töï ñoäng chaïy maïch in 
baèng caùch choïn Auto > Autoroute > Board. 

Sau moät luùc chôø chöông trình chaïy 
maïch in, thoâng baùo sau xuaát hieän, nhaáp OK ñeå 
thaáy sô ñoà maïch in. 

 
 

 Chöông trình chaïy maïch in nhö hình sau: 
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 Ñeå ñaët nhaõn hieäu cho maïch in, nhaáp chuoät 
vaøo bieåu töôïng Text Tool treân thanh coâng cuï, nhaáp 
phaûi chuoät vaøo maïch in, moät cöûa soå xuaát hieän,nhaáp 
chuoät vaøo New… 

  

 Hoäp thoaïi Text Edit xuaát hieän, taïi khung Text String nhaäp teân caàn ñaët cho maïch vaøo. 
Nhaäp teân xong nhaáp OK. 

 
 Con troû chuoät xuaát hieän haøng chöõ vöøa nhaäp, haõy di chuyeån con troû ñeán vò trí caàn ñaët cho 
maïch vaø nhaáp chuoät. 
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 Cuoái cuøng, nhaáp chuoät vaøo bieåu töôïng Save treân thanh coâng cuï ñeå giöõ laïi nhöõng gì ñaõ 
thöïc hieän. 

 
 

ÑAÏI HOÏC SÖ PHAÏM KYÕ THUAÄT – KHOA ÑIEÄN   BIEÂN SOAÏN : PHAÏM QUANG HUY  -  HUYØNH MINH ÑAÊNG 205 


